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Statement  

7ÅÌÃÏÍÅ ÔÏ ÕÓÅ ÔÈÅ ÐÒÏÄÕÃÔ ÆÒÏÍ 8ÉȭÁÎ .ÏÖÁ3ÔÁÒ 4ÅÃÈ #ÏȢȟ ,ÔÄȢ (hereinafter referred to as 

Ȱ.ÏÖÁ3ÔÁÒȱɊȢ )Ô ÉÓ ÏÕÒ ÇÒÅÁÔ ÐÌÅÁÓÕÒÅ ÔÏ ÏÆÆÅÒ ÔÈÉÓ ÍÁÎÕÁÌ ÔÏ ÈÅÌÐ ÙÏÕ ÕÎÄÅÒÓÔÁÎÄ ÁÎÄ ÕÓÅ ÔÈÅ 

product. We have striven for precision and reliability during the compilation of this manual, and 

the content of this manual is subject to change without notice. If you have any problem in use or 

you have any suggestion, please feel free to contact us according to the contact information 

provided in this manual. We will do our utmost to satisfy your needs. We would like to express 

our sincere thanks to your suggestions and make assessment for adoption as soon as possible. 

Copyright © 2017 NovaStar  

No part of this document may be copied, reproduced or extracted in any form or by any means 

without the prior written consent of NovaStar. All rights reserved. 

Trademarks  

 and  are registered trademarks owned by NovaStar. 

All other trademarks, brand, product, service and company names mentioned in this document 

may be trademarks, registered trademarks, trade names of their respective holders. 
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1  Overview  

SmartLCT is a new generation of LED display configuration software from NovaStar, in 

conjunction with LED display controllers for smart configuration of various complex LED 

displays, including building-block configuration, online/offline design, seam brightness 

adjustment, cabinet rotation, etc., to provide an easy access for users to operate LED displays 

and present you a perfect display.  

Features 

· Building-block configuration: Configure LED displays by adding cabinets via online or offline 

design and setting the position and physical connection of cabinets, which is easy to 

operate and flexible to configure.  

· Seam brightness adjustment: Effectively solved the issue of brightness adjustment of seams 

among cabinets or modules. Seam brightness adjustment supports single and multiple 

selection to present you a perfect display. 

· Canvas exporting: Users can export edited physical connections of cabinets and data related 

to devices in picture format.  

· Hot backup: Backup Ethernet ports and devices to make sure the LED display operates 

normally when primary devices and Ethernet ports cannot work normally, which provides 

users protection and effectiveness for LED display configuration.   

· Property settings of LED display controlling units including I/O source settings, color 

settings, PIP, montage, etc. 

  

Operating system: OS X, Windows 7 or above. 

1.1  Configuration  List  

Name Version/Model Function Notes 

SmartLCT V3.0 Operating Platform Standard 

LED Display 
Controllers  

3D HD, NovaPro HD 

K4/K4S 

VX2/VX4/VX4S 

V700/V800/V900 

MCTRL300/MCTRL500/MCTRLR5/

MCTRL600/MCTRL660/MCTRL4K 

Primary controllers of LED 
display and video processing 
units 

Optional 
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Receiving 
Cards 

MRV200/MRV210/MRV220/MRV30

0/MRV320/MRV330/MRV340/MRV

350/MRV360/MRV365 

 

Display driver modules of LED 
display 

Optional 

1.2  System Structure  
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2  Software Installation  

Just like the installation of other common software, install SmartLCT3.0 by following the setup 

wizard. 
 

 In case of antivirus or firewall popups during installation, please 
permit them because serial driver may need to be installed 
during program installation. 

 The installation program will update the serial driver on 
ÃÕÓÔÏÍÅÒÓȭ computer to the version of the driver in the 
installation package automatically if there is no serial driver or its 
version is too low. 
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3  Smart LCT  Interface Introduction  

3.1  Login  

After SmartLCT is installed successfully, click on the icon  to access the start page, as 

shown in the figure below. 

 
Create new online or offline projects, or open existing projects, then access the page of LED 

display configuration, as shown in the figure below. 
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3.2  Menu Bar/ Tool Bar  

Menu Bar/Tool Bar Icon Function 

Edit 

UndôCtrl̅ Z̃ 
 

Back to last step 

Redô Ctrl̅ Ỹ  
 

Cancel last step 

Group / 
All the cabinets will be edited or moved together after 
grouping. 

Ungroup / Recover the grouped cabinets to single cabinets.  

View 

Zoom in 
 

Zoom in the view of the cabinets on the screen. 

Zoom out 
 

Zoom out the view of the cabinets on the screen. 

1:1 / Display the cabinets with a scale of 1:1. 

Zoom to fit 
 

Adjust the cabinets to a viewable size on the screen. 

Online status / 
Select this option to show the status of the receiving 
cards connected to the Ethernet ports of the device. 
(Green denotes online while gray offline.) 

Cabinet info / 

Including Ȱ3ÅÎÄÉÎÇ card iÎÆÏȱȟ Ȱ0ÏÒÔ .ÏȢȱ ÁÎÄ 
Ȱ2ÅÃÅÉÖÉÎÇ ÃÁÒÄ ÉÎÆÏȱȢ 
The information of the option you selected will be 
shown on the cabinets. 

Auto connect / 
Select this option and the added cabinets will be 
connected automatically. 

Show grid / 
Select this option and the grid on screen area will be 
visible. 

Snap / 

Including Ȱ3ÎÁÐ ÔÏ ÇÒÉÄȱ ÁÎÄ Ȱ3ÎÁÐ ÔÏ ÃÁÂÉÎÅÔ ÅÄÇÅȱ. 
Select it, and when you moving a cabinet, the cabinet 
will snap to the border of its nearest grid or cabinet 
automatically.   

View 
 
Including Ȱ&ÒÏÎÔ ÖÉÅ×ȱ ÁÎÄ Ȱ"ÁÃË ÖÉÅ×ȱ ÆÏÒ ÃÈÁÎÇÉÎÇ 
ÕÓÅÒÓȭ ÖÉÅ× while looking at cabinet connections.  
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Operation 
(Online) 

Reconnect device 
 

Reconnect all the devices. 

Refresh device 
 

Refresh device status information 

Send 
 

Send screen configuration information to 
corresponding controllers. 

Save to hardware 
 

Save screen configuration information to hardware so 
as to avoid information loss. 

Hot backup 
 

Backup devices and Ethernet ports. 

Seam brightness 
adjustment 

/ Adjust brightness of the seams among cabinets. 

Test patterns 
 

Choose different screen test patterns. 

Tools Calculator / Open the calculator of Windows. 

Help 

UserȭÓ -ÁÎÕÁÌ / Get UserȭÓ -ÁÎÕÁÌ ÏÆ ÔÈÉÓ ÓÏÆÔ×ÁÒÅȢ  

About / Check the information related to this software. 

Language 
 

/ / Switch UI language between English and Chinese. 

 Delete lines 
 

Delete the lines among cabinets. 
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4  Language Settings  

SmartLCT supports two languages: English and Chinese. You can switch languages through 

following two ways. 

· Click Language on the start page and an option box appears, then select the language you 

want.  

  

· Access the page of LED display configuration. Click Language on the menu bar and a drop-

down menu appears, then select the language you want. 
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5  Offline Operation  

5.1  Creating Projects  

Run the software. Create a new project of LED display configuration in offline state. Click Create 

offline design on the page of Function to access the page of Create a new project. 

1)  Customize the project name and select the save path of the project. 

2)  Select the device: Select the matched controller. Here we take MCTRL4K as an example. 

3)  Select the cabinet: Select LED display cabinet manufacturer and type. 

4)  Screen size: Set the number of columns and rows of cabinets. 

5)  Connection type: Choose the way to connect the cabinets. 

  

5.1.1  Cabinet Management  

ː Select& Export: Export the information of selected cabinets to files 

ˑ Export all: Export all the cabinet information to files 

 

˒ Delete: Delete selected cabinets. 

˓ Add: Add new cabinets. 

˔ Edit: Edit selected cabinets.  
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5.1.2  View  Switching  

· The page of Create a new project includes two viewÓȡ Ȱ.ÏÒÍÁÌȱ ÁÎÄ Ȱ3ÍÁÒÔȱȢ 

· It only needs to name the project, choose the save path and select the cabinet in Ȱ.ÏÒÍÁÌȱ 

view. 



SmartLCT Userôs Manual 

www.novastar .tech                                                                     10  

 

5.2  LED Display  Configuration  

As shown in the figure below, the page of LED display configuration appears after a new project 

is created. 
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5.2.1  Device List  

Create new projects or click existing projects to access the page of LED display configuration. 

 

Click on the selected device to expand the drop-down list of Ethernet ports. Use your mouse to 

drag the scrollbar to view all ports. 

Add devices 

Click Add devices at the bottom of the device list to add new devices. 

 

· Click ÔÈÅ ÄÅÖÉÃÅ ÍÏÄÅÌÓ ÙÏÕ ×ÁÎÔ ÔÏ ÁÄÄ ÉÎ Ȱ/ÐÔÉÏÎÁÌ ÄÅÖÉÃÅÓȱȢ $ÏÕÂÌÅ ÃÌÉÃË on the field of 

Ȱ.ÕÍÂÅÒȱ column ÉÎ Ȱ/ÐÔÉÏÎÁÌ ÄÅÖÉÃÅÓȱ ÔÏ edit the number of cascaded devices. 
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· Click Add button on the middle area after a device is selected to add the device ÔÏ Ȱ3ÅÌÅÃÔÅÄ 

ÄÅÖÉÃÅÓȱȢ #ÌÉÃË OK after the device is added. 

Device Properties 

Select a cabinet on editing area and its properties are shown on property area. Here we take 

MCTRL4K as an example. 

 
Ȱ0ÒÏÐÅÒÔÉÅÓȱ ÉÎÃÌÕÄÅÓ Ȱ-ÁÎÕÆÁÃÔÕÒÅÒȱȟ Ȱ4ÙÐÅȱȟ Ȱ$ÅÖÉÃÅȱȟ Ȱ0ÏÒÔ ÎÁÍÅȱȟ Ȱ#ÏÎÎÅÃÔÉÏÎȱȟ 

Ȱ-ÁÐÐÉÎÇ ÐÏÓÉÔÉÏÎȱȟ Ȱ0ÏÓÉÔÉÏÎȱ ÁÎÄ Ȱ4ÅÓÔ ÐÁÔÔÅÒÎÓȱȢ 

Ȱ#ÏÎÎÅÃÔÉÏÎȱȡ 1-2-3 denotes sending card No. 1, port No. 2, receiving card No. 3. 

Ȱ-ÁÐÐÉÎÇ ÐÏÓÉÔÉÏÎ ȱȡ 4ÈÅ ÐÏÓÉÔÉÏÎ ÏÆ ÔÈÅ ÁÄÄÅÄ ÃÁÂÉÎÅÔ ÏÎ ÔÈÅ screen. 

Ȱ0ÏÓÉÔÉÏÎȱ: The position of the selected cabinet on the screen. 

Ȱ4ÅÓÔ ÐÁÔÔÅÒÎÓȱȡ #ÈÏÏÓÅ ÔÈÅ ÃÏÒÒÅÓÐÏÎÇÄÉÎÇ ÔÅÓÔ ÐÁÔÔÅÒÎ ÏÆ ÔÈÅ ÓÅÌÅÃÔÅÄ ÃÁÂÉÎÅÔȢ 

If devices with rotation function are connected, for example, MCTRLR5: 

Added Ȱ2ÏÔÁÔÉÏÎȱ ÆÕÎÃÔÉÏÎȡ 3ÅÌÅÃÔ Á ÓÉÎÇÌÅ ÃÁÂÉÎÅÔ and set its ritation angles, then is enables the 

rotation of a single cabinet. If many grouped cabinets are selected, set the rotation angle and all 

the selected cabinets will be rotated together. 
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5.2.2  Cabinet Conf iguration  

Add cabinets 

As shown in the figure below, click Add button on the tool bar to access the page of Manage 

cabinets. Then click on  to access the page of Edit added cabinet. 

Edit cabinet information such as manufacturer and cabinet name on the page of Edit added 

cabinets. After the information is edited, click Save and a new cabinet is created. 

 

ŕ  
 

Edit Cabinets 

Click Add button on the tool bar to access the page of Manage cabinets. Select the cabinet 

to be edited and click Edit button  to access the page of Edit added cabinet where cabinet 

information can be edited. Click Save after finishing editing, as shown in the figure above. 

Cabinet Connections 

As shown in the figure below, choose a cabinet connection type on the tool bar. There are two 

ways to connect cabinets. 
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I. Auto 

View>Auto connect 

Click View on the menu bar  and select ȰAuto connectȱ ÏÎ ÔÈÅ 

drop-down menu that appears. Select the matched device and ports from the device list at the 

left side of the page. Then click Cabinet button , hold and drag it into editing area, and 

you can click on the editing area repeatedly to add more cabinets. Right click on your mouse to 

cancel adding cabinets, then connection lines among the added cabinets will appear 

automatically (or hold and drag the mouse on the editing area to add more cabinets continually 

and connection lines among the added cabinets appear automatically, then right click on your 

mouse to cancel adding cabinets.). 

Note: 

The connection order is based on the adding order. You can select all the cabinets and select a 

connection type on the tool bar to change the connection of the cabinets. 

 

Add cabinets 
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Select cabinets 

 

Select new connection type 

II. Manual 

Click View on the menu bar  ÁÎÄ ÄÅÓÅÌÅÃÔ Ȱ!ÕÔÏ ÃÏÎÎÅÃÔȱ ÏÎ 

the drop-down menu that appears. Select the matched device and ports from the device list at 

the left side of the page. Then click and hold Cabinet button  and drag it into editing 

area, and you can click on the editing area repeatedly to add more cabinets. Select all the 

cabinets and choose a cabinet connection type from the tool bar, then cabinets on the editing 

area will be connected based on the connection type you choose. 

Note: 

After the cabinets on the editing area are connected manually, it is needed to choose and edit 

cabinet connection type again if new cabinets are added. 
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Add cabinets 

 
Select cabinets 

 
Select new connection type 

Delete Lines 
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Select the cabinets among which the lines will be deleted, and click on Delete lines button 

to disconnect the cabinets. 

 

5.2.3  Screen Properties  

Click on the blank of the screen and Properties of the screen will be shown on the right side of 

the page.  

Properties include grid color, grid spacing, disable edit. 

Grid color: Click on the icon  on the right side to select and edit grid color. 

Grid spacing: One grid spacing is 10 pixels (within 1~500). 

 

5.2.4  Load s of Ethernet  Ports  

You can view the loads of each Ethernet port at the bottom of editing area: Blue denotes that 

the load is normal and the detailed information can be shown. Red denotes the load is 

exceeded. 
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5.3  Hot Backup  

Click on Hot backup button   on the right side of toolbar to access the page of hot backup. 

 
Click the drop-down menu on the right side of Port name and select the port you want to back 

up on the page of Hot backup.  

 

Click on Add button   on the page of Hot backup to access the page of Add. 

 

5.4  Send  

Click  ÏÎ ÔÈÅ ÔÏÏÌ ÂÁÒ ÁÎÄ ÉÔ ×ÉÌÌ ÐÒÏÍÐÔ ÙÏÕ Ȱ$Ï ÙÏÕ ×ÁÎÔ ÔÏ ÍÁÔÃÈ ÄÅÖÉÃÅȩȱ 
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#ÈÏÏÓÅ Ȱ9ÅÓȱ ÁÎÄ ÓÅÌÅÃÔ ÍÁÔÃÈÅÄ ÏÎÌÉÎÅ ÄÅÖÉÃÅ ÏÎ Ȱ/ÎÌÉÎÅ ÄÅÖÉÃÅÓȱ. 

 

Choose ȰNoȱ ÁÎÄ ÄÏ ÎÏÔ ÓÅÎÄȢ 
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6  Online Operation  

6.1  Creating Projects  

Connect LED display controller to the PC used currently. Run the software. Refresh device list to 

show device model and screen size. 

  
Create new projects of LED display configuration in online state. Click Create online design to 

access the page of Create a new project. 

   
1)  Customize the project name and select the save path of the project. 

2)  Select the cabinet: Select LED display cabinet manufacturer and type. 
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3)  Screen size: Set the number of columns and rows of cabinets. 

4)  Connection type: Choose the way to connect the cabinets. 

6.1.1  Cabinet Management (See Cabinet Management  in offline stat e)  

6.1.2  View  Switching (See View  Switching  in offline stat e)  

6.2  LED Display Configuration  

Access the page of LED display configuration after new projects are created. Devices on the left 

are online, as shown in the figure below. 

 

6.2.1  Device List  

Create projects or click existing projects to access the page of LED display configuration. Device 

list is on the left side of the page. 

 

Click the device to expand Ethernet port list and use the mouse to drag the scrollbar to view all 

the ports. 

Device Properties 

Select a cabinet from editing area and the properties of the cabinet are shown on property area. 

See details in Device List in offline state. 
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Adjust Color of LED Display 

-ÏÖÅ ÏÎ ÔÏ Ȱ#ÏÌÏÒȱ ÔÁÂ ÔÏ ÁÄÊÕÓÔ brightness and Gamma of LED display. It allows you to 

ÃÕÓÔÏÍÉÚÅ ÃÏÌÏÒ ÔÅÍÐÅÒÁÔÕÒÅɉ2ȟ ' ÁÎÄ " ÂÒÉÇÈÔÎÅÓÓɊȢ 3ÅÌÅÃÔ Ȱ3ÙÎÃÈÒÏÎÉÚÅȱ ÔÏ ÁÄÊÕÓÔ R, G and B 

brightness synchronously. 

 

Source Mapping 

Move on to ȰSource mappingȱ ÔÁÂ ÔÏ ÖÉÅ× mapping position of current device (the position of 

the first added cabinet on LED display) and resolution of the video source of current device. 

 

Click Ȱ!ÄÖÁÎÃÅÄȱ to access advanced settings page of mapping of the selected device. Adjust 

mapping position to change cabinet position on the screen. 

Click the drop-ÄÏ×Î ÂÏØ ÁÔ ÔÈÅ ÒÉÇÈÔ ÓÉÄÅ ÏÆ Ȱ"ÁÃËÇÒÏÕÎÄȱ ÁÎÄ ÙÏÕ ÃÁÎ ÃÈÏÏÓÅ Ȱ$ÅÆÁÕÌÔȱȟ 

Ȱ'ÒÉÄÓȱ ÏÒ Ȱ0ÉÃÔÕÒÅÓȱ ÁÓ ÂÁÃËÇÒÏÕÎÄȢɉ4ÈÅ ÁÄÄÅÄ ÂÁÃËÇÒÏÕÎÄ ÉÓ ÁÐÐÌÉÅÄ ÏÎ ÁÄÖÁÎÃÅÄ ÓÅÔÔÉÎÇÓ 
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page only, and not shown on LED display.)   

 

6.2.2  Cabinet Configuration  (See Cabinet Configuration  in Offline State)  

6.2.3  Screen Properties (See Screen Properties  in Offline State)  

6.3  Seam Brightness Adjustment  

It is required to complete the configuration (refers to adding cabinets and connect them) on the 

page of LED display configuration. Click Operation>Fast Adjust Seam Data>Seam Brightness 

Adjustment to access the page of Seam Brightness Adjustment. As shown in the figure below, 

here we take VX4S as an example. 

The number of cabinets on the page of Seam Brightness Adjustment is the same as the number 

on the page of LED display configuration. 
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Buttons at the bottom right corner of the page include: 

· Send: For sending seam brightness information to sending cards.  

· Save: For saving current seam brightness information. 

6.3.1  Area Spl itting  

Click the icon on tool bar and the page of Area Splitting appears. Set the number of rows 

and columns after a cabinet is split, then click OK to see the result. 

Note: The number of rows and columns after a cabinet is split defaults to 5. 

  



SmartLCT Userôs Manual 

www.novastar .tech                                                                     25  

6.3.2  Cabinet Restoring  

Click the icon on tool bar to restore the spilt cabinet to original state. 

6.3.3  Selection  

Selection includes Ȱ3ÅÌÅÃÔ ÒÏ× ÁÎÄ ÃÏÌÕÍÎȱȟ Ȱ#ÏÌÕÍÎ ÓÅÌÅÃÔÉÏÎȱ ÁÎÄ Ȱ2Ï× ÓÅÌÅÃÔÉÏÎȱȢ 

Click the icon on tool bar, then click and drag your mouse to select cabinets and all the 

borderlines of the cabinets are selected, as shown in the figure(left)  below. 

Click the icon on tool bar, then click and drag your mouse to select cabinets and only 

horizontal borderlines of the cabinets are selected, as shown in the figure(middle) below. 

Click the icon on tool bar, then click and drag your mouse to select cabinets and only vertical 

borderlines of the cabinets are selected, as shown in the figure(right)  below. 

   

6.3.4  LED Details  

Click on the borders of any cabinets and LED details will appear on the right side of the screen. 

Details of LEDs on the right border of Cabinet4 are shown as the figure below. 

 
Select some of the LEDs, click and drag the slider on the rÉÇÈÔ ÓÉÄÅ ÏÆ Ȱ3ÅÌÅÃÔÅÄ !ÒÅÁ 0ÁÒÁÍÅÔÅÒÓ 

!ÄÊÕÓÔÍÅÎÔȱ to adjust the parameter (defaults to 1.000). The selected area will be shown on the 

border of the cabinet. 
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Meanings of different colors:  

Gray There is no adjustable value if 

not selected. 

Blue There is no adjustable value 

if selected. 

Light green There are adjustable values if 

not selected. 

Dark green There are adjustable values 

if selected. 

6.3.5  Display  Window  Mode s 

Click the button on tool bar to switch display window mode (free switch between normal 

mode and expanded mode). 

Show/Hide Display Number 

Click the button on tool bar to show cabinet numbers on display window. Click the button 

again to hide the numbers. 

 

 

Display Window Background 

Click the button on tool bar to choose the background color of display window. 
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6.3.6  Deleting  

Click the button on tool bar to deselect the borderlines of all the cabinets. 

Click the button on tool bar and a dialog box pops up to ÃÏÎÆÏÒÍ Ȱ(ÁÓ ÔÈÅ ÓÅÔ ÄÁÔÁ ÂÅÅÎ 

ÄÅÌÅÔÅÄ ÃÏÍÐÌÅÔÅÌÙȩȱ Choose Yes to restore the interface to original state. 

 

6.4  Restoring Seam Data  

After completing the configuration (refers to adding cabinets and connect them) on the page of 

LED display configuration. Click Operation>Fast Adjust Seam Data> Restore Seam Data to 

access the page of Restore Seam Data, as shown in the figure below. 

 



SmartLCT Userôs Manual 

www.novastar .tech                                                                     28  

Click on the icon  ÁÔ ÔÈÅ ÒÉÇÈÔ ÓÉÄÅ ÏÆ Ȱ3ÅÁÍ !ÄÊÕÓÔ &ÉÌÅȱ ÔÏ ÖÉÅ× ÁÎÄ ÃÈÏÏÓÅ Á ÐÁÔÈ ÔÏ save 

the file. After the file is loaded successfully, click Restore to restore the seam data which is 

adjusted before. Click Undo to cancel the operation to restore seam data.   

6.5  Hot Backup  

Click Hot backup button at the top right corner of the tool bar to access the page of Hot 

backup. 

 

Click Add button to access the page of adding backup. 

 

6.6  Sending  

Click the button on tool bar to send LED display configuration information to corresponding 

device. 

If the loading capacity of %ÔÈÅÒÎÅÔ ÐÏÒÔÓ ÉÓ ÅØÃÅÅÄÅÄȟ ÉÔ ×ÉÌÌ ÃÏÎÆÏÒÍ ȰIt exceeds the loading 

capacity. Sure to continue?ȱ   
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If the Ethernet ports can load normally, the information will be sent successfully. 

 

 




























